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ППррооггрраамм  ззаа  ттааббееллааррннее  ппррооррааччууннее  ––  EExxcceell 

 
Садржај је обрађен кроз четри вежбе које обухватају: 

 

 Основне појмове и покретање 

програма 

 Радни лист и радна свеска 

 Унос и форматизација података у 

ћелијама 

 Промена ширине колоне и висине 

реда 

 Убацивање и брисање ћелија, 

колона иредова 

 Уређење табеле 

 Рад са формулама и функцијама 

 Креирање и уређењ еграфикона 

 Практичне вежбе 

 Питања 
 

 

 

 

ВВеежжббаа  ббрр..1100 
ООссннооввннии  ееллееммееннттии,,  уунноосс  ии  ииззммееннаа  ппооддааттааккаа,,  ааууттооммааттссккоо  ппооппууњњаавваањњее  --  

ссеерриијјее  ии  ллииссттее 
 

Spreadsheet програми, тј. програми за унакрсна израчунавања, су у многоме помогли да 

персонални рачунари стекну своје место на тржишту и постигну успех који данас имају. 

Програм Excel је, захваљујући графичком радном окружењу Windows-a, као и интеграцији 

са текст процесором Word, базом података Access и неким другим програмима у пакет 

Microsoft Office, најпродаванији програм своје врсте на свету. Пошто је намењен најширем 

кругу корисника, подразумева се да се Excel-ови велики потенцијали могу искористити и без 

икаквог програмирања - нарочито у погледу рада са формулама и базама података, као и у 

представљању у облику графикона и табела и њиховом улепшавању. 
 

Активирање и напуштање програма Excel је на стандардни начин: 

• Каскадни мени StartPrograms MicrosoftExcel 

• Активирање иконе на радној површини (ако постоји) 
 

Основни елементи су: радна свеска (workbook), радни листови (worksheet) и 

ћелија (cell). 

Приликом стартовања програма Excel у прозору је приказан документ који називамо радном 

свеском (књигом - workbook) са приказаним тренутно активним радним листом (worksheet). 

Сваки радни лист је практично засебна целина, која се састоји од мреже колона (означених 

словима абецеде) којих максимално може бити 256 и редова (означених бројевима) којих може 

максимално бити 65536. У пресеку редова и колона налазе се ћелије (cell) које представљају 

најмању радну јединицу Excel-a. Свака ћелија има једнозначну адресу која се састоји од слова 

колоне и броја реда у којима се налази (A1, B8...). Између ћелија могу се дефинисати одређене 

везе, тако да се измена садржаја једне ћелије одражава и на садржаје с њом повезаних ћелија. 

Подаци и формуле се уносе у ћелије и тако се  формирају  радни листови. Њихов број се може 



Апликативни софтвер - Практикум 
 

62 

 

мењати до највише 256, а иницијално је постављен на 3. Основни елементи прозора програма 

Excel приказани су на Слици 43. 
 
 

 

Слика 43. Изглед основног прозора програма Excel 

 
Рад са документом је на већ раније описан (стандардни) начин који ће овде бити само 

укратко поновљен: 

Отварање новог документа: 

• Команда FileNew 

• 

 

Отварање постојећег документа: 

• 

• 
 

Чување документа: 

• Команда FileSave(чува под постојећимименом) 

• Команда FileSaveAs(увек отвара прозор заиме) 

• 
 

а што је приказано на Слици 44 

Активна 

ћелија Линија за унос и измену 

садржаја ћелије Заглавље 

колона 

Поље Name у којем се приказује 

референца активне ћелије 

Заглавље 

редова 
Траке за кретање 

Картице радних 

листова - Tab 

Статусна линија 

Команда File Open 
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Слика 44. Изглед дијалог прозора команди New и Save As 

 

Са радним листовима се рукује умногоме као и са самим ћелијама - могу се означавати 

(select), копирати или премештати у оквиру једне или више радних књига. Селекција радног 

листа је једноставна – кликне се мишем на жељену картицу. Ако их има пуно, па се не виде 

сви, са леве стране су стрелице за њихово померање. Ако је потребна селекција неколико 

радних листова, постоје два начина: уколико желимо да означимо неколико суседних 

листова кликнемо на први, а затим држећи притиснут Shift, на последњи у групи. За 

несуседне листове селектујемо њихове табове држећи притиснут тастер Ctrl. 

Додавање (insert) нових листова се обавља тако што се изабере онај испред кога се жели 

убацивање новог, затим се отвори Insert мени и изабере Worksheet. Брише се тако што се 

нежељени листови означе и изврши Delete Sheet команда из менија Edit. Премештање и 

копирање се изводе на сличан начин - означавањем праћеним са командом Move or Copy из 

менија Edit. Затим се у дијалог прозору унесе у коју књигу листови иду и испред ког листа се 

убацују. Ако се жели копирање а не премештање, само се кликне на 'Create a Copy' 

квадратић. Други начин за ове операције је вуци-и-спусти' (drag and drop): означе се табови 

листова које желимо да преместимо, и онда се мишем "одвуку" на жељено место. Копирање 

се изводи на исти начин само уз притиснут тастер Ctrl при одвлачењу. Промена имена 

радном листу ради се тако што се дупло кликне на његово име и унесе ново или опцијом 

Rename са помоћног менија. На помоћном менију се налазе и горе поменуте команде а што 

је приказано на Слици 45. 
 

Слика 45. Селекција радног листа, команде на помоћном менију, дијалог прозор 

команде Move or Copy 
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Ако је потребно, радни листови се могу привремено и "сакрити" помоћу    команде 

Format► Sheet►Hide, а касније их вратити са Unhide. 

Кретање мишем по документу је на потпуно исти начин као и у осталим Windows 

апликацијама. Постоји и могућност директног "скока" на жељену ћелију – притиском на F5 

(иди на) директно уносимо њену адресу или уносом референце у поље Name. Омогућено је 

референцирање на ћелије и области које се налазе на другом радном лист или чак и у другом 

фајлу. 

Мењање садржаја ћелије могуће је: 

▪ дупли клик на ћелију 
▪ променом у линији за унос када је ћелија активна 

▪ притиском на функцијски тастер F2 када је ћелија активна 

Завршетак рада је притисак на тастер Enter (прихватање ) или Esc (одустајање од 

измена ). 

Брисање садржаја ћелије: 

▪ притисак на <Backspace> или <Delete> на тастатури - брише садржај 

активне ћелије или селектованих ћелија 

▪ притиском на десни тастер миша и избором Clear Contents 

Брисање ћелија: 

▪ Команда EditDelete 

a што је приказано на Слици 46. 
 

 

Слика 46. Команде за брисање ћелија (Delete) или њиховог садржаја (Clear) 

 

Копирање (copy) и премештање (move) садржаја ћелија ради се потпуно исто као у свакој 

Windows апликацији. При смештању података на нову локацију сав ранији садржај циљних 

ћелија биће уништен. 
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Прављење серија података: 

 
Веома корисна функција Excel-а је попуњавање (fill) суседних ћелија сродним садржајем, 

као што су имена дана у недељи или месеци у години, или једноставно убацивање редних 

бројева. Када желите да попуните већи број ћелија истим садржајем, довољно је да га 

откуцате само у једној. Затим миша доведете изнад ње и превучете је (притиском на леви 

тастер) преко оних које желите да попуните. Онда из Edit менија изаберите Fill и из његовог 

подменија смер у коме желите попуњавање - биће прекопиран садржај и формат почетне 

ћелије. Ова врста копирања може да се изведе и из једног радног листа у друге. За копирање 

садржаја и формата ћелије се бира All, само за садржај Contents а само за формат Formats, 

праћено наравно са Ok. 

За разлику од функције Fill која само копира садржај, Auto Fill је много "паметнији", тако 

да ако, рецимо, желимо да унесемо дане у недељи, довољно је да откуцамо само први дан 

(Monday) и повучемо "ручицу за попуњавање" (има је свака означена ћелија, представља је 

мали квадрат у доњем десном углу) у жељеном смеру. Када се миш доведе изнад њега, 

стрелица се претвара у мали знак '+'. По отпуштању дугмета на мишу, Excel ће сам попунити 

додатне ћелије одговарајућим данима Сличне листе можемо креирати и сами, потребно је 

урадити следеће: У Tools менију изаберемо Options, па затим Custom Lists таб. Кликом на 

ставку NEW LIST, курзор се појављује у List Entries пољу. Унесемо ставке листе и 

притиском на Add (када можете дефинисати још неку листу), или OK завршавамо унос, а 

што је приказано на Слици 47. 
 

 

 

Слика 47. Попуњавање (fill) и унос нове листе 

 

Креирање серије је веома једноставно: унесе се вредност у почетну ћелију, означе се 
ћелије које треба попунити и изменија Edit изаберемо команду Fill► Series.
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Изаберемо да ли се серија шири по колони или реду, врсту серије и корак (Step value) и 

зауставну вредност (Stop value) као што је приказано на Слици 48. 

У већини случајева Excel ће схватити шта се жели и самим повлачењем ручице за 

попуњавање. 
 

 

Serija Inicijalni
podaci 

Rezultujućaserija 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Linearna 1,2 3,4,5 

100,99 98,97,96 

1,3 5,7,9 

Porast 
(Growth) 

10 

(korak 5) 

50, 250, 1250 

10 

(korak 10) 

100, 1000, 10000 

Datum Mon Tue, Wed, Thur 

Feb Mar, Apr, May 

1995 1996, 1997, 1998 

AutoFill Team 1 Team 2, Team 3, Team 
4 

Qtr 4 Qtr 1, Qtr 2, Qtr 3 

1st Quarter 2nd Quarter, 3rd 
Quarter, 4th Quarter 

 

Слика 48. Команде за прављење серија различитих типова 
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Уради Вежбу: 
 

 

1. Направите нови документ програма Excel. Прегледајте делове прозора програма Excel 

и проверите да ли су на прозоруприсутне: 

• стандардна палета саалаткама; 

• палета са алаткама за форматирање; 

• линија за уписивање садржаја; 

• статусна линија. 
 

Празној радној свесци доделите име Prva и сачувајте је у фолдеру Excel који ћете 

направити у фолдеру ваше групе. 

 

2. У документу Prva: 

• промените имена радних листова: Sheet1 у Podaci, Sheet2 у Tabela. 

• Уклоните радни лист Sheet3. 

Сачувајте овако измењенидокумент. 

 

3. На радном листуPodaci: 

• У ћелију В1 упишите:  Име и презиме (ваше име ипрезиме) 

• У ћелију В 2 упишите: Место и годинарођења 

• У D7 – 12345; F11 –2009. 

 
4. Додајте нови радни лист и подесите да буде последњи. Промените му име у 

Automatskopopunjavanje. 

 
5. У радном листу Automatskopopunjavanje увежбајте копирање садржаја ћелије у 

суседне ћелије истог реда или колоне, повлачењем ручице за копирање. Пробајте са 

следећим садржајем: 

• Једне ћелије: а) 2000;  б) Испит 1;  в) Sunday;  г)Feb. 

• Две суседне ћелије: а) 2000 и 2002; б) 1990 и 1995; в) ДАН и МЕСЕЦ. 

Сачувајте измењену радну свеску Prva. 
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ВВеежжббаа  ббрр..1111 
ФФооррммааттиирраањњее  ссааддрржжаајјаа  ћћееллиијјее,,  ппррооммееннаа  шшииррииннее  ккооллооннее  ии  

ввииссииннее  ррееддаа,, 
 
 

Садржај који је унет у неку ћелију (или скуп ћелија) можемо форматирати избором 

команде Cell менија Format. Добија се прозор са више картица приказаних на Слици 49. 
 

Формат броја: изглед фонта: 

• број децималних места и формат • назив, стил, величина, 

негативних бројева  боја и специјални ефекти 
 

формат датума: поравнањe и оријентацијaтекста: 

• тип приказа датума •хоризонтално, вертикално, оријентација 

текста и прелом текста 
 

Слика 49. Опције које се могу подешавати избором команде Format Cell 
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Ту је и дијалог за оквире (Border), при чему и на линији са алаткама можемо наћи 

одговарајуће команде као што је приказано на Слици 50. 
 

 

Слика 50. Подешавање оквира 

 

Промена ширине колона и висина редова подешава се: 

➢ из менијаFormat: 

Ширинаколоне: Format→Column→Width 

Висина реда: Format→Row→Height 

  
Задавање ширинеколоне Задавање висинереда 

 

➢ мишем тако што се поинтер примакне заглављу, а затим повуче жељена ивица 

  
Мењање ширине колоне G, и реда 6. 
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Уради Вежбу: 
 

1. Отворите радну свеску Prva коју сте формирали у претходној вежби. На 

радном листу Podaci форматизуј унети садржај на следећи начин: 

• У ћелију В1 где пише Име и презиме (фонт: Arial, подебљана, закошена 

слова, величина 15 pt, ћирилица), централно поравнање. Промени 

ширину колоне да се види цеотекст. 

• У ћелију В 2 где пише Место и година рођења (фонт: Verdana, подебљана 

слова величине 10) и оријентација текста вертикална (90
0
). 

• У D7 – 12345, поравнање централно, боја бројева црвена 

• У F11 – 2009, поравнање лево, боја у ћелији жута, боја бројева зелена. 

 

2. На радном листу Tabela направите доле приказану табелу и форматирајте је на 

приказан начин. 
 
 

 

3. Промени спољни оквир табеле да буде двострука линија. 

4. Сачувајте овако измењени документ под новим именом Druga у истом фолдеру где је 

био документ Prva. 
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ВВеежжббаа  ббрр..1122 
ИИззррааддаа  ии  ууррееђђеењњее  ддиијјааггррааммаа  ((ггррааффииккооннаа)) 

 

 

 

Графикон представља графички (визуелни) приказ вредности садржаних у табели. Пре 

почетка рада са графиконима, објаснимо нове термине које ћемо користити: 

Data Series– серије података чине групе података повезаних неким релацијама (обично је то 

само један ред или колона табеле или радног листа). 

Axis– оса, представља једну страну графикона. У дводимензионалном имамо x-осу 

(хоризонталну) и y-осу (вертикалну), а у тродимензионалном графикону z-оса 

представља вертикалу, а x-оса (одстојање) i y-оса (ширина) представљају две 

стране "пода". 
Legend– легенда, дефинише значење разних делова графика. 

Да бисмо креирали графикон, прво морамо селектовати податке које желимо приказати 

графички, а сам поступак израде дијаграма (chart) u Excelu могућ је на неколико начина: 

 

• Притиском на функцијски тастер F11 графикон се креира на посебном листу; 

• Из менија Insert наредбом Chart; 

• Помоћу Excelovog чаробњака (ChartWizard) из линије са алаткама . 

Уз помоћ чаробњака графиком креирамо кроз 4 корака: 

1. Бирамо тип графикона Chart Type, где ако нисмо нашли одговарајући у стандардној 

понуди избором Custom Types добијамо додатне графиконе изведене из стандардних. 

Притиском на дугме Press and Holdt o View Sample, видећемо умањен приказ 

изабраног графикона базираног на селектованим подацима, а што је приказано на 

слици51. 
 

 

Слика 51. Први корак: избор типа дијаграма 
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Постоји приличан број разноврсних предефинисаних типова графикона. 

Основне групе су: 

- Column (вертикални стубичасти дијаграм-хистограм), 

- Пие (пита, кружни дијаграм који се користи за приказивање релација између делова 

целине за једну серију података), 

- Line (линијски дијаграм најбоље приказује трендове и промене које се јављају 

током времена), 

- Bar (хоризонтални тракасти дијаграм који је 'заокренути стубичасти 

дијаграм'), 

- Area (области, служе за приказивање промене у вредностима). 

Већину основних типова можете представити у тродимензионалном облику. 

2. Притиском на тастер Next, долазимо до дијалога где одређујемо опсег података који 

ће бити приказан графиконом ChartSourceData. Ту одређујемо и да ли се серије 

налазе у редовима или колонама. Ако смо у старту направили погрешну селекцију 

података можемо је исправити директним куцањем у поље Range, или поновним 

превлачењем мишем преко жељене области (ако приказани дијалог смета, кликните 

мишем на икону са црвеном стрелицом у углу поља за опсег и дијалог ће се смањити – 

величину му враћате истим кликом). На картици Series можемо дати имена серијама 

података, а што је приказано на Слици52. 
 

 

 

Слика 52. Други корак: избор опсега података 

 

3. Избором Next долазимо до опције Chart Options где можемо подешавати следеће 

опције графикона: 

- Titles нуди могућност насловљавања графикона, као и давања имена осама; 

- Axes омогућава укључење исписа натписа поред оса; 
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- Gridlines служи за укључење главних и споредних линија мреже по све три осе; 

- Legend омогућава приказивање легенде као и њено позиционирање на 

графикону; 

- Data Labels укључује исписивање имена или вредности уз сваки део 

графикона; 

- Data Table, омогућава укључивање табелу са вредностима испод графикона. Неке од 

ових опција приказане су на Слици 53. 

 
 

 

Слика 53. Трећи корак: подешавање опција дијаграма 

 

4. Поновним избором Next долазимо до последњег корака Chart Location и дијалога у 

коме бирамо да ли ће се графикон појавити на новом радном листу креираном само за 

њега, или на неком од постојећих. Притиском на тастер Finish завршавамо креирање 

графикона као што је приказано на слици 54. 
 

 

 

Слика 54. Четврти корак: избор локације дијаграма 

 

Графикону се може по вољи мењати величина ручкама на срединама страна као и у 

његовим теменима, а може се и вући и постављти на жељено место. 

Кликом на графикон можемо га учинити активним и мењати његову форматизацију, или 

чак додавати нове или избацивати постојеће серије података. То радимо на следећи начин: 

означимо ћелије у табели, укључујући и имена категорија и серија података које желимо да 

додамо. Одвуче се мишем жељена област на жељену позицију на дијаграму и посао је готов. 

Ако је потребно неку серију избацити, само се на њу кликне и затим притисне тастер Delete. 
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Уради Вежбу: 
 

 

1. Отворите радну свеску Druga коју сте формирали у претходној вежби. Додајте нови 

радни лист и доделите му име Dijagram. Сачувајте измењену радну свеску у фолдеру 

Excel у фолдеру ваше групе под именом Treća. 

 
2. Прекопирајте Табелу 1 са радног листа Tabela на радни лист Dijagram, а назив табеле 

промените у Табела 2. Прекопирана табела. На основу података из прекопиране 

табеле на истом радном листу направите стубичасти дијаграм који приказује 

зависност броја прекршаја (за сваку врсту) од дана у седмици. Дијаграм треба да 

садржи наслов, називе координатних оса исписаних ћирилицом и легенду постављену 

надну. 

 
3. На новом радном листу Tipovidijagrama формирајте табелу састављену од 

претколоне и колоне СН, Табеле 1.  Назив табеле треба да буде:   Табела 3. 

Саобраћајне незгоде. Направите три дијаграма на основу података из ове табеле: 

• стубичасти; 

• линијски и 

• прстенасти. 

 

4. Сачувајте измењену радну свеску. 
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ВВеежжббаа  ббрр..1133 
РРаадд  ссаа  ффооррммууллааммаа  ии  ффууннккцциијјааммаа,,  ооббррааддаа  

ппооддааттааккаа  уу  ттааббееллии 
 
 

Основна намена Excel-а су табеларна израчунавања. Да би нешто могло да се рачуна, 

треба задати формуле зависности одговарајућих ћелија. 

Формула: Једначина у којој се над подацима унетим у радни лист извршавају операције 

као што су сабирање (+), одузимање (-), множење (*) и дељење (/). Формуле увек почињу 

знаком (=), и увек треба притиснути тастер Enter да би потврдили формулу. Компоненте 

формуле се називају аргументи и они могу бити референце ћелија или бројеви (константе). 

Редослед извршавања рачунских операција не разликује се од стандардне математике. 

Формула се уноси куцањем или означавањем адреса ћелија. Прво означите ћелију у којој 

желите да се појави резултат. Затим куцате знак једнакости (=) који Excel-у говори да ћете 

унети формулу, а за њим и саму формулу. Резултат се израчунава чим притиснете Enter. 

Други начин је у ствари исти, с том разликом да не уносите ручно адресе ћелија које 

садрже операнде, већ их селектујемо мишем а Excel сам уписује адресе. Овако се могу 

уносити како адресе појединачних ћелија тако и области (превлачењем). Ако желите да 

прекинете унос и занемарите откуцани део, довољно је да притиснете Esc. 

Исте операције могу се обавити и у посебном пољу за унос формула (Formula bar). Лево 

од поља за унос су тастери са ознакама 'X' i '' који имају исту улогу као и тастери Esc и 

Enter, а што је приказано на Слици 55. Ту је и тастер са ознаком 'fx' који активира додатни 

алат за уношење сложених формула –функција. 
 

 

 

Укуцати формулу користећи поинтерски 

режим рада: 

 

=A1*A2-A3+A4*A5/A6 

 

Израчуната ћелија је ћелија која садржи 

прорачун, али приказује резултат прорачуна. 
 

 

 

 

 

 

 

 

 
 

Слика 55. Приказ уноса формуле у ћелију 
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Поруке о грешкама: 

➢ #### ћелија садржи тачан податак који је сувише велик да би се приказао у ћелији, 

треба подесити ширину колоне; 

➢ #VALUE! Формула садржи текст (или референцу ћелије која садржи текст), а 

Excel очекује број; 

➢ #DIV./0! Покушали сте да делите са нулом; 

➢ #REF! Формула садржи референцу на ћелију која више не постоји јер је 

избрисана. 

 

Функција је унапред дефинисана формула, уграђена у Excel, која се користи за 

одређену намену. Навешћемо неке од најчешће коришћених функција: 

 

▪ SUM (number1, number2, …) или SUM (number1: number2) – где су number1, number2, 

... од 1 до 30 аргумент типа бројчаног податка за које се рачуна збир, односно 

референца прве и последње ћелије опсега за који се рачуна сума. Ова функција 

занемарује ћелије које садрже текст или супразне. 

 

▪ AVERAGE (number1, number2, ...) где су number1, number2, ... од 1 до 30 

аргумент типа бројчаног податка за који се рачуна средња вредност. 

 

▪ MIN и MAX користимо за проналажење најмање односно највеће вредности у датој 

групи ћелија. 

 

▪ COUNT омогућава да у датој групи ћелија пребројимо уписане бројчане 

вредности. 

 
Када уносимо функцију прво означимо ћелију која треба да садржи резултат, затим 

уносимо функцију из менија Insert ► Function 
 

 

Слика 56. Дијалог прозор команде за унос функције 

 

Појављује се дијалог као на слици 56. Категорију бирамо из листе категорија (Select a 

category), тако да се у делу за функције (Select a function) појављују само оне које припадају 

тој категорији. Ова подела је врло згодна за лакше   проналажење 
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жељене функције. Под категорије спадају између осталих финансијске (Financial), 

математичке (Math&Trig), статистичке (Statistical), као и посебне: скуп свих функција (All) 

или оних које су најскорије употребљене (Most Recently Used). Испод се налази синтакса и 

детаљнији опис функције која је тренутно изабрана. 

 

Када се одлучите за категорију и функцију коју желите да примените, притисните Enter 

на тастатури или тастер OK у дијалогу. Приказаће се нови дијалог који представља други (и 

крајњи) корак чији садржај зависи од аргумената изабране функције, а наведено је њено име 

и кратак опис. Могу се директно куцати адресе а омогућен је и унос мишем, тако што се 

кликне на жељену ћелију, када сам Excel уноси њену адресу. Као аргумент се може унети и 

нека друга функција. Поред поља у које се уносе аргументи одмах се приказује и њихова 

вредност, а у доњем левом углу дијалога је поље са називом Formula result у коме се одмах 

добија резултат. Све наведено за функцију SUM приказано је на Слици56. 

Цела операција се завршава притиском на дугме OK, када се формула преноси у табелу и 

производи ефекат. 
 

 

Слика 56. Дијалог прозор за избор аргумената изабране функције SUM 
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Уради Вежбу: 
 

 

1. Отворите радну свеску Treća коју сте формирали у претходној вежби. Додајте нови 

радни лист и доделите му име Formule i funkcije. Сачувајте измењену радну свеску у 

истом фолдеру под именомČetvrta. 

2. Прекопирајте Табелу 1 са радног листа Tabela на радни лист Formule i funkcije и 

означите је са Табела 4 (прва колона табеле нека буде у колони B). Прекопираној 

табели додајте колону и ред Укупно. Форматирајте додатне елементе табеле, тако да 

буду уочљиви (обојте ћелије другом бојом). Израчунајте одговарајуће вредности у 

колони и реду Укупно. 

3. Промените вредности у Табели 4 такoдa укупан број прекршаја по врстама не буде 

једнак. Посматрајте како се мењају сумарне вредности (ћелије у којима су формуле) 

када мењате вредност ћелије у којој је аргумент. 

Додајте ред Просек и израчунајте просечан број прекршаја по врстама. 

 

4. Формирајте Табелу 5 са почетком у колони Ј тако што ћете прекопирати заглавље 

Табеле 4 и ред Укупно. Табели доделите назив Преглед прекршаја по врстама. 

Приликом копирања користите Paste Special, са потврђеном опцијом Values. У 

претколони нове табеле уместо речи Дан напишите Врста прекршаја, а уместо 

Укупно, Број прекршаја. 

 

Напомена: Табела 5 треба да изгледа слично овој: 

 
5. Додајте нови ред Табели 5 на следећи начин: у претколони новог реда напишите 

Заступљеност, а у ћелијама за податке израчунајте процентуалну заступљеност сваке 

врсте прекршаја у односу на укупан број. Формулу за израчунавање заступљености 

напишите тако да се можепрекопирати. 

6. Сачувајте измењену раднусвеску. 

7. Направите нови документ програма Excel.  Прекопирајте следећу табелу: 

Табела 1. 

Преглед броја саобраћајних незгода на подручју 

АБЦ у периоду 1996–2000. год. 

Mес. / Год. 1996. 1997. 1998. 1999. 2000. 

Јануар 1180 1315 1603 1758 1797 

Фебруар 997 1100 1252 1383 1545 

Март 995 1205 1301 1410 1523 

Април 1142 1241 1358 1469 1648 

Мај 1535 1837 2091 2084 2447 
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Јун 2879 2989 3337 3428 4028 

Јул 8938 9707 10753 10909 12626 

Август 8219 9103 9806 9352 10022 

Септембар 2652 2886 3032 3205 3522 

Октобар 1394 1507 1776 1777 2202 

Новембар 1055 1208 1298 1448 1626 

Децембар 1030 1174 1197 1330 1440 

 

Након копирања подесите изглед табелa (димензије колона и редова, оквири). 

Дајте радном листу име Mesečni pregled. Сачувајте измењену радну свеску у 

фолдеру Excel фолдера ваше групе под именом Poslednja. 

8. На радном листу Mesečni pregled: 

• графички прикажите број саобраћајних незгода за сваку годину (5 серија на истом 

дијаграму), у зависности од месеци. За тип дијаграма изаберите линијски. 

Дијаграм треба да садржи наслов, називе оса и легенду. 

• Додајте табели нове редове који ће садржати: 

✓ укупан број незгода током једне године (Укупно), 

✓ просечан број незгода (Просек), 

✓ максималан број незгода током године (Маx), 

✓ минималан број незгода током године (Min), 

✓ разлику између максималног и минималног броја током године 

(Распон). 

• Прикажите графички: просек, минимуме и максимуме у зависности од 

година. 

 

9. Сачувајте овако измењену радну свеску. 
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Одговори на питања: 
 

 

 

1) Шта је Excel? 
 

 

2) Документ у програму Excel назива се  и састоји се од радних 

листова (Sheet), којих може бити . (допуните реченицу). 
 

3) Који тип датотеке се користи за табеларне прорачуне (spreadsheets)? 

a) .mp3 

b) .doc 

c) .gif 

d) .xls 

 
4) Како се назива ова линија са алатима? 

 

Линија . 
 

5) Адреса (референца) ћелије представља: 

a) Ознаку колоне у мрежи радне табеле у којој се налази ћелија 

b) Ознаку реда у мрежи радне табеле у ком се налази ћелија 

c) Ознаку положаја ћелије у мрежи радне табеле. 
 

6) За селектовање опсега несуседних ћелија користимо тастер: 

a) Shift 

b) Ctrl 

c) F2 

d) Alt 

7) Када се притисне тастер Delete на тастатури, брише се садржај ћелије и сама ћелија 

a) Тачно 

b) Нетачно 
 

8) Поље Name приказује: 

a) Референцу ћелије која је тренутно активна 

b) Име радне свеске 

c) Име радног листа 

d) Ваше име 
 

9) Excel-ов тастер за едитовање садржаја ћелије (Edit) је: 

a) Alt 

b) F2 

c) Insert 

d) Ctrl 
 

10) Нови радни лист додаћете командом из менија . 
 

11) Радни лист премештате командом из менија Edit. 
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12) Уклањање ћелија извршавате командом: 

a) Clear из менија Edit 

b) Delete из менија Edit 

c) Cells из менија Format. 
 

13) Сваки прорачун или математичка формула почиње знаком  

(доврши реченицу). 
 

14) У формули се може употребити само један оператор 

a) Тачно 

b) Нетачно 
 

15) У формулама се могу користити: 

a) само бројне вредности 

b) бројне вредности и адресе ћелија 

c) само адресе ћелија. 
 

16) Копирање редова у колоне и колона у редове табеле омогућава потврда опције 
___________________у дијалогу команде Paste Special. 

 

17) Ако измените вредност у ћелији, морате поново унети све формуле у којима се та ћелија 

референцира да би се поново израчунала њихова вредност? 

a) Тачно 

b) Нетачно 
 

18) Функција SUM ће јавити грешку ако један од њених аргумената није број 

a) Тачно 

b) Нетачно 

19) Алатку Autofill можете употребити за: 

a) Копирање бројева и текста у суседне ћелије 

b) Инкрементално копирање месеци у години и дана у недељи у суседне ћелије 

c) Копирање формула у суседне ћелије 

d) Све претходно 
 

20) Функција AVERAGE рачуна: 

a) аритметичку средњу вредност аргумената 

b) разлику аргумената 

c) суму аргумената. 
 

21) Шта ради функција MAX?  
 

22) Шта означава низ повисилица (####) у ћелији?  
 

23) Навести најмање два начина за креирање графикона: 
 

 
 

 

24) Дијаграмј е могућесместити: 

a) искључиво у радни лист у ком се налази табела 

b) у нови радни лист или у неки од постојећих 

c) само у нови радни лист. 
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25) Да ли је могуће мењати тип дијаграма после завршене израде: 

a) не 

b) само код неких типова дијаграма 

c) да. 
 

26) Тракастидијаграм може садржати: 

a) Само једну тачку података 

b) Само једну серију података 

c) Више серија података 

d) Више цртежа 
 

27) Ако се променис адржај извора података на основу којег сте направили дијаграм, 

морате поново направити дијаграм из почетка да би био ажуран 

a) Тачно 

b) Нетачно 
 

28) Кружни дијаграм може садржати: 

a) Само једну тачку података 

b) Само једну серију података 

c) Више серија података 

d) Више цртежа 

29) Прозор за дијалог Chart Source Data садржи картице: 

a) Patterns и Font 

b) Standard Types и Custom Types 

c) Data Range и Series. 


